Sex Differences in Arterial Destiffening with Weight Loss

Elizabeth R. Ehrlich

Thesis submitted to the faculty of Virginia Polytechnic Institute and State University in partial fulfillment of the requirements for the degree of
Master of Science
in
Human Nutrition, Foods and Exercise

Kevin P. Davy, Chair
Madlyn I. Frisard
Jose M. Rivero

June 30, 2011
Blacksburg, VA

Keywords: arterial stiffness, weight loss, obesity, sex
Sex Differences in Arterial Destiffening with Weight Loss

Elizabeth R. Ehrlich

ABSTRACT

Given the current obesity epidemic in tandem with the aging US population, it is imperative to identify methods for reducing cardiovascular disease (CVD) risk that will be efficacious for both sexes. Arterial stiffness (AS) is an independent risk factor for a first cardiovascular event that increases with advancing age and obesity. Previous studies have found that modest weight loss (WL) of 5 to 10 percent successfully reduces AS and other risk factors for CVD. However, it remains unclear whether WL via caloric restriction reduces AS similarly among sexes. We tested the hypothesis that WL via caloric restriction would reduce AS more in men than women because men accumulate more abdominal visceral fat (VF) and lose more with WL compared with women of similar age and adiposity. To test our hypothesis AS was assessed from measurements of pulse wave velocity and ultrasonography of the carotid artery (β-SI). Total body and VF were measured using dual energy x-ray absorptiometry and computed tomography scans, respectively. Subjects underwent a 12-week WL intervention. No baseline differences in AS were observed between sexes. However, men were heavier and demonstrated higher levels of VF while women were fatter and had higher levels of abdominal subcutaneous fat. Contrary to our hypothesis both sexes experienced similar decreases in AS with WL despite greater reductions in VF in men. Our findings suggest that VF loss is not the primary mechanism mediating reductions in AS with WL. Future studies are needed to determine the mechanisms of arterial destiffening with WL.

REFERENCES

Acknowledgements

I would like to thank my committee members for their guidance and support. I would especially like to thank Dr. Davy for welcoming me into his laboratory as an undergraduate and supporting me in my pursuit of a master degree in Human Nutrition, Foods and Exercise. In addition I would like to thank my lab mates for always being willing to lend a hand, and my friends and family for never ceasing to believe in me.
# Table of Contents

Acknowledgement iii
Table of Contents iv
List of Tables v
List of Figures vi
Chapter 1: Introduction 1
  References 4
Chapter 2: Sex Differences in Arterial Destiffening with Weight Loss 8
  Abstract 8
  Background 9
  Materials and Methods 9
    Measurements 10
    Statistical analysis 11
  Results 12
  Discussion 13
  References 22
Chapter 3: Summary 26
  References 27
Appendices 29
  Appendix A: Measurements 29
  Appendix B: Informed consent form 34
  Appendix C: Institutional Review Board approval 41
LIST OF TABLES

Chapter 3:

Table 1. Medication use by group 16
Table 2. Subject characteristics before and after weight loss 17
Table 3. Macronutrient intake and physical activity before and after weight loss 18
Table 4. Changes in risk factors for arterial stiffness before and after weight loss 19
LIST OF FIGURES

Chapter 3:

Figure 1. Pulse wave velocity before and after weight loss (women n=14; men n=8)
   *P<0.05 Time Effect

Figure 2. Beta stiffness index before and after weight loss (women n=15).
   *P<0.05 Time Effect
Chapter 1: INTRODUCTION

The prevalence of obesity in adults ages 20-74 has skyrocketed over the past 30 years. From 1976 to 2006 the percentage of the adult population that is obese has risen from fifteen percent to thirty-five percent.¹ Currently an estimated one billion people are overweight or obese Worldwide and this number is expected to grow.²,³ As obesity increases, so does the prevalence of obesity-related diseases such as diabetes, hypertension, and increased risk of heart disease and stroke.¹

As people age not only does their risk for obesity increase, so does their risk for chronic disease.⁴,⁵ The United States population greater than 65 years of age is predicted to double by the year 2030.¹ An aging population may result in increased demands placed on the health care system due at least in part to obesity and obesity related disease. Obesity and its associated health care costs are predicted to account for as much as sixteen to eighteen percent of total US health care expenditure by 2030.⁶ Diseases of the vasculature, which constitute one third of deaths in the US each year, will probably become a major contributor to rising health care expenditures.

There are two main functions of the arterial system. The first is to serve as conduit and deliver blood flow to organs and tissues according to their metabolic activity. The second function is to act as a cushion and dissipate the pulsatile ejection from the heart so blood flows to tissues in a steady and continuous stream. The second function is determined by arterial compliance defined as the ability of an artery to expand and recoil in response to changes in intravascular pressure. Reductions in compliance (i.e., stiffening) can impair the ability of the aorta to buffer cardiac pressure pulsations and create a steady and continuous blood flow. Aortic
stiffening results in an increase in pulse wave velocity (PWV), increased wave reflection, and elevation in systolic blood pressure (SBP) and pulse pressure (PP).\(^7\)

The primary determinant of arterial stiffness is an artery’s intrinsic elastic properties.\(^8\) Specifically, the relative elastin-collagen composition of the intimal medial layer and vascular smooth muscle effect the biomechanical properties of an artery.\(^9\) Over time, arteries stiffen as elastin fibers fragment, collagen fibers accumulate, and smooth muscle tone increases.\(^9\,10\) Importantly, an increase in collagen cross-linking promotes increased arterial stiffness.\(^11\)

As arteries stiffen PWV, SBP and PP increase and a rise in left ventricular workload and subsequent hypertrophy occurs.\(^10\) Concomitantly, diastolic blood pressure (DBP) falls and leads to impaired coronary perfusion.\(^10\) In addition, arterial stiffness is closely correlated with early stage atherosclerosis and endothelial dysfunction, an independent predictor of cardiovascular mortality.\(^12,13,2\) Aortic stiffness at baseline is associated with elevated risk for first cardiovascular events in middle aged and older adults as assessed The Framingham Heart study via PWV.\(^14\)

Over time, cardiovascular disease risk increases in part due to aging of the arterial system. Advancing age is associated with progressive wall thickening, and increases in lumen area.\(^9,7,15,16,17,18,19\) Aging is also associated with increasing arterial stiffness, which is an important risk factor for increased morbidity and mortality.\(^10,15\) The primary effects of arterial aging can be seen between the ages of ~20 and ~80 years when aortic stiffness increases 40-50% whereas peripheral arteries show little or no change in stiffness.\(^15,16-18,20\)

Advancing age also results in progressive increases of total body and abdominal fat.\(^21\) Independent of gains in total fat mass, increases in visceral fat are associated with greater cardiovascular risk than fat deposited elsewhere on the body.\(^2,21,22\) In addition, weight gain and
obesity have been linked to arterial stiffening.\textsuperscript{23} Importantly, the results of several studies suggest that visceral fat accumulation is associated with arterial stiffness in both non-obese and obese individuals.\textsuperscript{22, 24, 25}

There are a number of efficacious pharmacological and lifestyle approaches to reduce arterial stiffness. Recently, Dengo et al.\textsuperscript{26} hypothesized that weight loss via hypocaloric diet would reduce arterial stiffness in overweight and obese middle-aged and older adults. Weight loss of five to ten percent of bodyweight resulted in significant reductions in arterial stiffness as determined by measurements of PWV and carotid beta stiffness index. The magnitude of reduction in arterial stiffness was associated with the magnitude of reduction in total body and abdominal fat. Take together with previous studies,\textsuperscript{27, 28} these findings suggest that weight loss by caloric restriction is an efficacious arterial destiffening therapy and the magnitude of arterial destiffening is related to the degree of total body and abdominal visceral fat loss.\textsuperscript{26}

Decreases in abdominal visceral fat with weight loss are primarily a function of initial visceral fat level.\textsuperscript{9} The ratio of decreases in abdominal visceral fat to total body fat with weight loss is greater for individuals who have more abdominal visceral fat at baseline. Given that men tend to have more abdominal visceral fat than women, we believe that with weight loss via caloric restriction, greater reductions in arterial stiffness would be observed in men than women.\textsuperscript{2}

To our knowledge no other studies have previously addressed this topic.
REFERENCES


Chapter 2: Sex Differences in Arterial Destiffening with Weight Loss

ABSTRACT

We hypothesized that among middle aged and older obese individuals, weight loss would reduce arterial stiffness more in men compared with women. To test our hypothesis sixteen female and nine male overweight and obese (25<BMI<40 kg/m^2) adults ages 55-75 years old underwent weight loss via caloric restriction (females=1200Kcal, males=1500Kcal). Body weight, body composition (dual energy x-ray absorptiometry-DEXA), waist circumference (WC), blood pressure (BP), and arterial stiffness (AS) were measured at baseline and again following the 12-week intervention. AS was measured via pulse wave velocity (carotid-femoral artery PWV) and carotid artery ultrasonography combined with applanation tonometry [for calculation of β-stiffness index]. Body weight, WC, systolic and diastolic BP, were similar in the two groups at baseline (all P>0.05) and declined similarly (P>0.05) with weigh loss. carotid-femoral pulse wave velocity (CF-PWV) and β-stiffness index were similar at baseline in men and women and there was no significant difference in the decline in CF-PWV or β-stiffness index in two groups. Taken together, the findings from the present study suggest that weight loss reduces AS similarly in overweight and obese middle-aged and older men and women. As such, weight loss may be an effective therapeutic strategy for altering the course of vascular aging in both men and women.
BACKGROUND

Obesity is a multidimensional risk factor for cardiovascular disease. Numerous studies have indicated that age-related increases in weight are positively associated with cardiovascular mortality. In addition, reductions in visceral fat and associated cardiovascular risk factors with weight loss are determined, at least in part, by the initial level of visceral fat. Aging and weight gain are also positively linked to an increase in arterial stiffness, which independently predicts cardiovascular events and mortality.

Multiple strategies have been implemented to reduce arterial stiffening such as pharmacological and lifestyle interventions. Several studies have indicated that weight loss via hypocaloric diet is successful in reducing arterial stiffness. However, whether a sex difference in arterial destiffening with weight loss exists has not been explored. One notable difference between sexes is that visceral fat accumulation is greater in men compared with women, which is associated with a clustering of cardiovascular disease risk factors. In addition, reductions in visceral fat and associated cardiovascular risk factors with weight loss are determined, at least in part, by the initial level of visceral fat. Therefore we tested the hypothesis that men would experience greater arterial destiffening compared with women following twelve weeks of hypocaloric diet induced weight loss.

MATERIALS AND METHODS

Twenty five adults (age 55-75; BMI >25) underwent a 12-week weight loss program via caloric restriction (1200-1500 kcal/d) based on U.S. Department of Agriculture food guide pyramid guidelines. All subjects were free from overt cardiovascular disease as assessed by a medical professional, and were non-smokers that lived sedentary to recreationally active
lifestyles. Additionally, none of the subjects were taking any medications that affected appetite or weight (Table 1.). The Virginia Polytechnic Institute and State University Institutional Review Board approved the study protocol. Prior to signing an informed consent all subjects were briefed on the methods, as well as potential risks and benefits of their participation.

All individuals met with a dietitian. The subject’s weight was measured weekly. All measurements were taken between 8:00 am and 11:00 am following a 12hr fast and abstaining from vigorous activity for the previous 48 hours. Post measurements were only obtained after each subject was weight stable for at least two weeks.

**MEASUREMENTS**

Brachial blood pressure was measured via automated spygmomanometry. Subject diets were tracked using self-reported 4-day food intake records. The intake records were analyzed for energy and macronutrient intake using commercially available nutrition software (NDS-R 6.0, University of Minnesota). Body weight was found to the nearest 0.1 kg using a digital scale (Scale-Tronix Model 5002). WC was measured using spring loaded Gulick measuring tape. Physical activity was tracked via accelerometry (GT1M, Actigraph Inc.). Percent body fat was determined via dual energy x-ray absorptiometry (GE Lunar Prodigy Advance, software version 8.10e). Plasma lipid and lipoprotein concentrations were measured in a commercial laboratory. Plasma glucose and insulin concentrations were determined using the YSI 2300 Stat Plus glucose analyzer (Yellow Springs Instruments) and commercially available ELISA (Diagnostic Systems Laboratory) respectively.

Reductions in visceral fat as well as abdominal fat distribution were measured using computed tomography (CT) and commercially available analysis software (Hi Speed CT/I, GE
Medical, Slice Omatic Software Version 4.3, Tomovision) as described previously. Briefly, images between L4 and L5 were used to quantify total and subcutaneous fat. Abdominal visceral fat was then calculated by subtracting abdominal subcutaneous from total abdominal fat.

Carotid artery stiffness and PWV were measured as previously described. Briefly, carotid artery images were obtained via B-mode ultrasound and diameters were quantified using commercially available analysis software (Vascular Research Tools 5, Medical Imaging Applications, LCC). Carotid blood pressure was measured via applanation tonometry. Carotid femoral PWV was determined (Windaq, Data Instruments) via analysis of 10-20 cardiac cycle applanation tonometry recordings (Probe STP-301, Millar Instruments). A tape measure was used to determine the linear distance from the carotid to the femoral recording sites to the nearest 0.5cm. The measured distance did not change following weight loss (P<0.05). Travel distance by travel time from foot to foot of recorded pulse waves was used to calculate PWV. The carotid-femoral and radial PWV measurements were used to assess aortic and brachial artery stiffness respectively. Stiffness of the left common carotid artery was quantified using the $\beta$-Stiffness Index:

$$\beta\text{-Stiffness Index} = \frac{\ln(P_s/P_d)}{(D_s-D_d)/D_d}$$

**STATISTICAL ANALYSIS**

Subject characteristics at baseline and following intervention were compared using independent samples t-tests. Repeated measures ANOVA was used to identify time, group, and interaction effects. A significance level of $P<0.05$ was set *a priori.*
RESULTS

Subject characteristics in men and women at baseline and following intervention are presented in Table 2. Age, body mass index (BMI), WC, total fat, and systolic blood pressure (SBP) did not differ in the two groups at baseline. However, the men were taller, heavier and demonstrated greater weight and abdominal visceral fat compared with the women at baseline. Body weight (-6.1 ± 1.0 vs. -8.8 ± 1.3 kg; P<0.05), percent body fat (-2.2 ± 0.7 vs. -4.4 ± 0.6 %), BMI (-2.3 ± 0.3 vs. -2.8 ± .4 kg/m²), WC (-5.5 ± 1.4 vs. -8.6 ± 1.2 cm), SBP (-8.2 ± 1.6 vs. -4.4 ± 4.0 mmHg), diastolic blood pressure (DBP) (-5.1 ± 1.0 vs. -4.78 -4.78 ± 2.7 mmHg) total abdominal fat (-85.9 ± 16.0 vs. -126.7 ± 24.0 cm²) and abdominal subcutaneous fat (-56.7 ± 12.3 vs. -52.2 ± 12.5 cm²) all decreased similarly in both sexes following intervention. Abdominal visceral fat decreased more in men than women (-26.0 ± 7.7 vs. -74.5 ± 13.8 cm²; P < 0.05) following weight loss.

The reductions (P<0.05) in total energy, carbohydrate, fat, and dietary sodium intake with weight loss were similar (P>0.05) in men and women. In addition, physical activity (i.e., steps/day) did not change differently in men and women over the course of the weight loss intervention (Table 3.). Total cholesterol, triglycerides, high-density lipoproteins (HDL), very low density lipoproteins (VLDL), low density lipoproteins (LDL), glucose, and insulin saw significant changes over the course of the study. However, these factors changed similarly among men and women over time (Table 4.). There was no difference between groups at baseline or following intervention amongst lipid, lipoprotein, glucose or insulin plasma concentrations.

Neither beta stiffness nor pulse wave velocity was significantly different between men and women at study onset or following weight loss. Beta stiffness index (-1.5 ± 0.3 vs. -.78 ± .31
Units, Figure 1) and PWV (-155.5 ± 32.8 vs. -240.8 ± 65.7 cm/s, Figure 2) decreased with weight loss in both groups but the magnitude of reduction was similar in men and women. The magnitude of reduction in abdominal visceral fat and was not correlated with the magnitude of reduction in beta stiffness index (r=-.274; P>0.05).

DISCUSSION

In contrast to our hypothesis, weight loss reduced arterial stiffness similarly in men and women despite larger reductions in abdominal visceral fat in men. These findings suggest that the favorable effect of weight loss on cardiovascular health is mediated, at least in part, by its impact on arterial stiffness.8,9,12 However, reductions in abdominal visceral fat do not appear to be the primary mechanism mediating the arterial destiffening effect of weight loss. Taken together, these results indicate that weight loss is an efficacious arterial destiffening therapy in both men and women.

To our knowledge, our study is the first to address sex differences in arterial destiffening that occurs as a result of weight loss via hypocaloric diet. We recently reported that modest weight loss (five to ten percent) reduced arterial stiffness in overweight and obese middle aged and older adults.8 In accordance with previous studies, our current findings identify reductions in BMI via caloric restriction as an efficacious method of reducing arterial stiffness.8,9,12 BMI has been positively associated with arterial stiffness and also decreased with weight loss intervention similarly in men and women.13 In addition, our study as well as others observed decreases in pulse wave velocity with weight loss intervention.14,15 However, these studies did not identify sex-specific effects of weight loss on arterial stiffness.

13
Our observations are consistent with previous studies indicating that men lose more visceral fat with weight loss compared with women. These results are not surprising given that greater visceral fat deposits at baseline, as observed in the men in our study, are associated with greater reductions in visceral fat as a result of weight loss intervention. Interestingly, greater reductions in abdominal visceral fat with weight loss in men were not associated with correspondingly greater reductions in arterial stiffness.

Potential mechanisms responsible for reductions in arterial stiffness with weight loss are not clear. However, several possibilities exist including improvements in endothelial function and reduced smooth muscle tone. In the present study blood pressure, lipid and lipoprotein concentrations as well as markers of glucose tolerance decline similarly in both groups. Thus suggesting the effect of changes in these or other variables (e.g., reductions in sympathetic nervous system activity, renin-angiotensin-aldosterone system activity, or alterations in collagen cross-linking) result in similar net influence on arterial stiffness with weight loss in men and women.

Additionally, we cannot exclude the possibility that the similar reduction in arterial stiffness with weight loss in men and women in the present study was simply the result of similar reductions in blood pressure. However, beta stiffness index, our blood pressure independent measure of arterial stiffness, also declined similarly with weight loss among men and women. These finding suggest that factors other than blood pressure may have contributed to destiffening.

There are some limitations of our study that should be acknowledged. First, the sample size of the groups was relatively small. Second, we studied middle-aged and older men and postmenopausal women. The age group and or menopausal status of the cohort
utilized may have resulted in similar reductions in arterial stiffness with weight loss in men and women. Whether weight loss reduces arterial stiffness similarly in younger men and premenopausal women is not known. Finally, our study involved only short-term weight loss. Whether or not benefits would be sustained with long-term weight loss maintenance is unclear.

In summary, the findings of the present study suggest that weight loss via caloric restriction reduces arterial stiffness similarly in middle-aged and older men and postmenopausal women. The similar reductions in arterial stiffness occurred despite larger reductions in abdominal visceral fat in the men. Taken together, our findings suggest that the weight loss is an efficacious arterial destiffening therapy in both men and women. Future studies utilizing larger sample sizes are needed to discern whether the similar reductions in arterial stiffness weight loss in middle-aged and older men and postmenopausal women are sustained over longer periods and also are observed in younger samples.
<table>
<thead>
<tr>
<th>Medication</th>
<th>Female</th>
<th>Male</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hormone Replacement Therapy</td>
<td>4</td>
<td>---</td>
</tr>
<tr>
<td>Plavix</td>
<td>---</td>
<td>1</td>
</tr>
<tr>
<td>Hydrochlorothiazide</td>
<td>1</td>
<td>---</td>
</tr>
<tr>
<td>Lisinopril</td>
<td>---</td>
<td>1</td>
</tr>
<tr>
<td>Flomax</td>
<td>---</td>
<td>1</td>
</tr>
<tr>
<td>Avodart</td>
<td>---</td>
<td>1</td>
</tr>
<tr>
<td>Dyazide</td>
<td>---</td>
<td>1</td>
</tr>
<tr>
<td>Lipitor</td>
<td>---</td>
<td>3</td>
</tr>
<tr>
<td>Crestor</td>
<td>1</td>
<td>---</td>
</tr>
<tr>
<td>Foxamax</td>
<td>2</td>
<td>---</td>
</tr>
</tbody>
</table>
Table 2. Subject characteristics before and after weight loss

<table>
<thead>
<tr>
<th>Subject Characteristic</th>
<th>Women N=16</th>
<th>Men N=9</th>
<th>P&lt;0.05</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PRE</td>
<td>POST</td>
<td>PRE</td>
</tr>
<tr>
<td>Age (yr)</td>
<td>60.6±1.1</td>
<td>62.2±1.3</td>
<td></td>
</tr>
<tr>
<td>Height (m)</td>
<td>1.6±0.01</td>
<td>1.8±0.02</td>
<td></td>
</tr>
<tr>
<td>Weight (kg)</td>
<td>80.4±3.4</td>
<td>74.4±3.0</td>
<td>92.0±2.0</td>
</tr>
<tr>
<td>Body Fat Percent (%)</td>
<td>44.9±1.3</td>
<td>42.7±1.6</td>
<td>33.3±1.1</td>
</tr>
<tr>
<td>Total Body Fat (kg)</td>
<td>34.6±2.2</td>
<td>30.8±2.1</td>
<td>29.1±1.2</td>
</tr>
<tr>
<td>Body Fat Percent (%)</td>
<td>30.3±0.9</td>
<td>28.0±0.8</td>
<td>29.4±0.5</td>
</tr>
<tr>
<td>Waist Circumference (cm)</td>
<td>100.5±2.4</td>
<td>93.9±1.8</td>
<td>105.3±1.5</td>
</tr>
<tr>
<td>Abdominal Subcut. Fat (cm²)</td>
<td>437.5±31.3</td>
<td>380.9±29.1</td>
<td>314.3±23.1</td>
</tr>
<tr>
<td>Abdominal Visceral Fat (cm²)</td>
<td>152.1±17.0</td>
<td>126.1±14.1</td>
<td>217.8±22.2</td>
</tr>
<tr>
<td>Total Abdominal Fat (cm²)</td>
<td>592.8±41.6</td>
<td>506.9±38.4</td>
<td>532.1±25.6</td>
</tr>
<tr>
<td>Systolic Blood Pressure (mmHg)</td>
<td>123±2.5</td>
<td>114.7±1.7</td>
<td>123±2.7</td>
</tr>
<tr>
<td>Diastolic Blood Pressure (mmHg)</td>
<td>71±1.7</td>
<td>66±1.7</td>
<td>78±2.2</td>
</tr>
</tbody>
</table>

Values expressed as mean ± SE. For visceral and subcutaneous fat measures n=15.

* P<0.05 Time Effect
† P<0.05 Group Effect
‡ P<0.05 Interaction Effect
### Table 3. Macronutrient intake and physical activity before and after weight loss

<table>
<thead>
<tr>
<th></th>
<th>Women N=16</th>
<th></th>
<th>Men N=8</th>
<th></th>
<th>P&lt;0.05</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PRE</td>
<td>POST</td>
<td>PRE</td>
<td>POST</td>
<td></td>
</tr>
<tr>
<td>Dietary Sodium (mg)</td>
<td>3067.5±228.4</td>
<td>2211.3±105.3</td>
<td>3475.0±311.5</td>
<td>2669.0±369.0</td>
<td>*</td>
</tr>
<tr>
<td>Dietary Carbohydrate (%)</td>
<td>47.8±2.558</td>
<td>50.3±3.3</td>
<td>45.4±2.6</td>
<td>49.1±4.7</td>
<td>*</td>
</tr>
<tr>
<td>Dietary Fat (%)</td>
<td>36.1±1.8</td>
<td>32.7±2.4</td>
<td>34.4±1.6</td>
<td>29.6±3.1</td>
<td>*</td>
</tr>
<tr>
<td>Energy (Kcal)</td>
<td>1947.5±124.8</td>
<td>1281.7±55.1</td>
<td>2099.8±171.1</td>
<td>1583.4±176.1</td>
<td>*</td>
</tr>
<tr>
<td>Physical Activity (Steps)</td>
<td>7023.6±1061.7</td>
<td>8640.0±957.1</td>
<td>7786.0±780.3</td>
<td>7613.4±864.4</td>
<td>*</td>
</tr>
</tbody>
</table>

Values expressed as ± SE of mean
* Time effect
Table 4. Changes in risk factors for arterial stiffness before and after weight loss

<table>
<thead>
<tr>
<th></th>
<th>Women N=16</th>
<th>Men N=9</th>
<th>P&lt;0.05</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Pre</td>
<td>Post</td>
<td>Pre</td>
</tr>
<tr>
<td>Triglycerides (mg/dl)</td>
<td>112.75±11.1</td>
<td>99.31±14.1</td>
<td>105.67±13.9</td>
</tr>
<tr>
<td>Total Cholesterol (mg/dl)</td>
<td>210.63±9.2</td>
<td>197.8±8.48</td>
<td>200.89±16.0</td>
</tr>
<tr>
<td>HDL (mg/dl)</td>
<td>48.6±2.6</td>
<td>47.1±2.3</td>
<td>43.2±5.0</td>
</tr>
<tr>
<td>VLDL (mg/dl)</td>
<td>22.5±2.3</td>
<td>19.7±2.8</td>
<td>21.0±2.8</td>
</tr>
<tr>
<td>LDL (mg/dl)</td>
<td>139.5±8.8</td>
<td>131.0±7.4</td>
<td>136.7±13.9</td>
</tr>
<tr>
<td>Glucose (mg/dl)</td>
<td>86.8±4.3</td>
<td>82.5±4.4</td>
<td>92.1±4.7</td>
</tr>
<tr>
<td>Insulin (IU)</td>
<td>29.4±3.9</td>
<td>25.0±3.2</td>
<td>33.92±5.3</td>
</tr>
</tbody>
</table>

Values expressed as ± SE of mean; HDL=High density lipoprotein cholesterol; VLDL=Very low density lipoprotein cholesterol; LDL=Low density lipoprotein cholesterol.

* P<0.05 Time effect
Figure 1. Pulse wave velocity before and after weight loss (women n=14; men n=8)

*P<0.05 Time Effect
Figure 2. Beta stiffness index before and after weight loss (women n=15).

*P<0.05 Time Effect
REFERENCES


8. Dengo AL, Dennis EA, Orr JS, Marinik EL, Ehrlich E, Davy BM, Davy KP. Arterial
destiffening with weight loss in overweight and obese middle-aged and older adults.
_Hypertension_. 2010;55:855-861

LM. The effect of weight loss with or without exercise training on large artery

10. Gray DS, Fujioka K, Colletti PM, Kim H, Devine W, Cuyegkeng T, Pappas T. Magnetic-
resonance imaging used for determining fat distribution in obesity and diabetes. _Am


obesity and related comorbid conditions after diet-induced weight loss or exercise-
induced weight loss in men. A randomized, controlled trial. _Ann Intern Med._
2000;133:92-103

LM, Struijker-Boudier HA, Safar ME, Staessen JA. Obesity is associated with
increased arterial stiffness from adolescence until old age. _J Hypertens._
2005;23:1839-1846

Tanaka K, Ajisaka R. Effect of weight reduction with dietary intervention on arterial
distensibility and endothelial function in obese men. _Angiology_. 2009;60:351-357

CHAPTER 3: SUMMARY

Obesity is a chronic disease that has reached epidemic proportions.\(^1\) Excess fat, particularly visceral fat, is a major risk factor for CVD.\(^2\) As the American population becomes more obese, complications related to weight, including increased CVD, will add substantial burden to the health care system.\(^3\) Methods to identify and treat obesity-related cardiovascular dysfunction are needed to reduce cardiovascular events and associated health care costs.

Arterial stiffness is associated with adverse CVD outcomes.\(^4\) Arterial stiffness results from remodeling of the vasculature that occurs with age and weight gain. Elastin fibers of the intimal medial layer fragment with age while collagen cross-linking enhances stiffness. In addition, arterial stiffness is closely correlated with early stage atherosclerosis and endothelial dysfunction.\(^5\)\(^-\)\(^7\) Age-related stiffening is of great concern given that it has been estimated that the population over 65 will double by the year 2030.\(^8\) However, weight loss and pharmaceutical interventions have been successful in improving compliance of the central arteries. Given the short-term nature of the present weight loss intervention, reductions in arterial stiffness were more likely the result of improvements in endothelial function rather than changes in the elastin and collagen composition of the arterial wall.

Overweight and obese subjects exhibit greater stiffness when compared to normal BMI counterparts.\(^9\) In particular, visceral obesity is highly associated with decreased arterial compliance.\(^2\)\(^,\)\(^5\)\(^,\)\(^10\) Some of the major consequences of decreased compliance include hypertension, left ventricular hypertrophy, and increased cardiac workload.\(^11\) However, weight loss has been shown to significantly improve cardiovascular function and reduce CVD risk.\(^12\)\(^-\)\(^14\)
Men tend to have more abdominal visceral fat at baseline and lose more visceral fat following intervention.\textsuperscript{2} Our study suggests that despite greater abdominal visceral fat loss in men, similar decreases in arterial stiffness occur in both sexes with weight loss via caloric restriction. These findings suggest that visceral fat may not be the main mechanism of arterial destiffening. Nonetheless the possibility of gender specific mechanisms contributing to arterial stiffening cannot be excluded.

Weight loss has a dramatic impact on human physiology and metabolism. In addition to reducing fat mass, similar improvements in lipid profile as well as plasma glucose and insulin concentrations were observed in men and women in the present study. As such, the similar arterial destiffening among men and women in the present study is not surprising. Future studies are needed to determine the mechanism(s) of arterial destiffening following weight loss. Whether or not there are gender specific mechanisms that improve compliance has yet to be discovered. Identifying mechanisms will open the door to targeted interventions, which may hold a key to long-term cardiac health improvements.

Currently multiple methods including pharmaceuticals, diet, exercise and weight loss surgery are used to treat cardiovascular diseases and their symptoms. The benefit of diet and exercise over some pharmacological treatments is the ability to prevent disease onset. A cost effective, simple method of determining stiffening of the vasculature in a clinical setting could help identify the early signs of adverse changes to the vessel wall and elevated risk for adverse cardiovascular events.\textsuperscript{15}
REFERENCES


Appendix A: Measurement of Arterial Stiffness Indices

Pulse Wave Velocity (Carotid-Femoral or Carotid-Radial)

\[ \text{PWV} = \frac{\text{Distance (cm)}}{\text{Time (s)}} \]

Equipment set-up

Note: The balance for channel 1 and channel 2 should be kept permanently at 500

1. Turn on the Millar box (black) and other box next to it.
2. Open Windaq USBO from the start menu.
3. Move the tool box to the upper right corner.
4. Go to edit → Sample rate and type “800” → OK
5. Go to Edit → Select channels → Unclick channel 2 select channel 6.
   a. Only channel 6 and 6 should be selected.
6. Go to View → Format screen → Choose 2 waveforms
7. With the Millar box on “stand by”, click the save button on the toolbox → Select the folder where the data will be stored.
8. Change the file size to 2500 for longer recording time.
9. Status at the bottom will read “Record” → calibrate by pressing 25mmHg and 100mmHg buttons on the Millar Box. Frist press the 25mmHg button and a box will start forming, then press it again to stop, and press the 100mmHg button and make a box of similar width to that of the 25mmHg. Repeat this sequence resulting in 25-100-25-100mmHg boxes → click the save icon on the toolbox to stop recording.

Patient Set Up

1. Before starting to set-up for the PWV session make sure that the participant has met the following conditions:
   a. 12 hour fast
   b. no intake of prescription or over the counter drugs during the last 24-48 hours
   c. No illness during the previous week
   d. No exercise 24 hours before testing.
2. Ask the participant if he/she needs to use the bathroom
3. Briefly remind the participant what the session entails.
4. Clean the area for the ECG lead placement by scraping with sand-paper and wiping with alcohol. Place the 3 leads and make sure the ECG shows up correctly on the ultrasound machine monitor. To adjust the ECG gain select “physio” and rotate the knob where “ECG gain%” is displayed.
5. Put the blood pressure cuff on the left arm and set the cuff interval to 2.5.
6. Offer the participant a blanket and allow them to rest. Ask them to relax but not fall asleep, and to not cross their feet. If the participants are older or have back problems, offer to place a pillow underneath the knees and a blanket
7. Dim the lights and leave the room or sit there quietly. Check the blood pressures 10 min into the session and at 20 min. If the person seems to be nervous or easily startled it may be better to remain in the room
8. If blood pressures are stable after 15-20 min rest, the session may be started.
9. While obtaining the measurements do not engage in conversation with the participant.
10. When ready to record a waveform, set the Millar box to “Transducer” and once a good quality image is obtained click the save button to record.
11. Once the session is finalized close the file. Always do this before turning off the Millar and the other box because if not Windaq will freeze the computer.
12. Wipe the tonometer tip with an alcohol wipe, let dry and put away. If the femoral artery was measured always clean the tonometer.

**Pulse wave velocity analysis**
1. Open master file (Windaq)
2. Browse the entire master file before selecting the pulse waveforms to be analyzed, and check the subject’s chart for notes. It is possible that several recordings exit for the same arterial segment of interest, and they could be out of order in the master file
3. If waves are not visible for one of the channels, click on that channel and scroll up or down to find them. To scroll, click on the channel screen and drag the cursor to make a rectangle and click inside it, hold the left mouse button down and move the mouse in the desired direction. Adjust the wave size by using “up” and “down” arrows.
4. Choose the waves to be analyzed→Place the cursor before the 1st wave of interest→Hit F4 twice and at the bottom fo the screen it will read .0000 SEC→a mark will appear→move the cursor 25-30 waves past the 1st selected wave.
5. Press F7→compression 1
6. Save as→verify the option reads: visible and binary (with CODAS header)→save new file as: subjectID_CF_session# (date may be included, CR-PWV=CR)
7. Exit the master file without making changes to it, “exit with no save”
8. Open the newly created Windaq file.
9. File→Calculate→Save all→blue screen pops up →Type the “c” key (copy channel)→Enter→Escape.
10. A new blue screen pops-up to specify which channel is going to be copied and what channel will contain the new copy. Destination channel: usually channel 3→enter→Enter source channel: select channel 1 (contains the carotid waveform)→Choose continue to “copy” and another channel with the distal artery wave recordings [repeat steps: destination channel=4, and source channel=2 (distal artery)]→Exit the blue screen
11. File→Calculate→Save all→blue screen appears→Hit “P” (peak detector)→Esc
12. Enter channel number to capture: 1 (original channel)→Channel number to be marked: 3 (copied channel)→Select capture mode V (Valley)→Leave threshold as is →Esc
13. Repeat steps for distal artery channel→exit blue screen
14. View→Format screen→choose 4 waveforms. The original and copied channels will appear. Channels 3 and 4 will be marked at the ascending foot of each wave.
15. Return to a 2 waveform view→channels 1 and 3 are automatically shown→go to view→assign channel 1=3 and 2=4 to view the copied/marked channels.
16. F7→compression 7
17. View→Format screen→select 2 waveforms overlapped. Click on the channels to flatten the waves with the “down” arrow. Examine the gap between the carotid and femoral (or radial) artery marks to make sure they are not exactly over each other or that there are no exaggerated gaps between some of them.
18. View→format screen→select 2 waveforms. Use the “up” arrow to unflatten them.
19. To move from foot to foot: hold down the control key and use the left and right arrows. The size of the waves can be changed by using the “up” and “down” if needed. Analyzed the contour and the maker on each wave to determine if it is acceptable or if it should be
deleted. To delete place the cursor right on top of the mark and press delete. Make sure to also delete the wave in the other channel.

20. To insert a maker: place the cursor in the desired spot (beginning of the upstroke find lowest voltage-use compression 1 to verify spot) and press “insert” twice. Note: optimally there are 20 quality waves selected at the end of the revision. This may not be the case because of deleted waves (quality over quantity), 10-12 waves must be available for date.

21. To record the pulse travel times: move from the ascending foot of one wave to another and write down the time shown on the lower left corner [Data 6.265 sec (TBF)].

22. Exit from file by selecting “save all”.

**B. Ultrasound methods**

Patient Set up

1. Follow instructions in PWV session.

Ultrasound machine set up

1. Power on
2. Insert optimal disk
3. Select “patient id”→enter the subject’s ID, gender, and session (DOB and other info are optional).
4. Press “Patient id” to exit.
5. Place a towel and the transducer gel next to the US machine.
6. To finish a session: press “disk” and “end study”.
7. Power off the US machine.

Ultrasound imaging and calibration of the carotid artery blood pressure

Note: image is obtained at the left common carotid artery. Right carotid waveform is recorded via applanation tonometry (make sure to get at least 10 waves of similar amplitude). If pulse wave tonometry is not obtained at the same time of the US proceed to record the carotid artery waveforms immediately after US.

1. Select 10* carotid waveforms from the master file→save→exit without saving. *If 10 good quality carotid pulse waves are not available then choose as many as you can. Try not to use less than 4 to calibrate.
2. Open Windaq file of interest. File→calculate→save all→blue screen→“C” to copy channel containing carotid artery waveform→Enter→Esc
3. File→Calculate→Save all→blue screen→“P” (Peak detector)→Enter the channel to be marked and the source channel→“PV” (peak-valley)→Exit Verify that the first and last mark is a “valley” (if not delete “peak” or insert “valley”) and review placement of the marks
4. File→calculate→save all→“G” key (generate point-value data file)→Enter→Esc
5. Blue screen specify which channel is going to be reported→report channel 3→select “VV” (valley to valley)
6. Import data into excel. Data→import external data→find Windaq file (folder: view all files and it has blue squiggly icon)→Delimited→Tab and comma→Finish
7. Average the valley, peak and mean (4 decimals). Shift the decimal place of the valley and mean to the right and use 2 decimals, i.e., 2.0834→20.83
8. Return to Windq and press F9 (low calibration). Input level=valley(aa.bb.); low calibration value=brachial diastolic blood pressure (average of the resting blood pressures once stabilized).
9. Press F11 (high calibration). Input level=mean(xx.yy); high calibration value=mean arterial pressure (calculate from the average resting bp, use 2 decimals).
10. File→calculate→Save all→“G” (Generate point-value data file0→enter→esc.
11. Report Channel 3→select “VV” (valley to valley)
12. Import the generated report into excel file (same as above). Average valley, peak and mean (no decimals), these values are the diastolic, systolic and mean blood pressure, respectively. Save excel file and delete blue squiggly Windaq file.

Image Retrieval (manual method):
1. Open Q lab
2. Click the folder and find the file on the E Drive.
3. If several images are recorded for the same session, usually the last one (check date and time) is the best quality.
4. Do not adjust the contrast of the image or the brightness to avoid altering the diameters
5. Play the recorded Us
6. Goal: select 5 images (15 frames) of diastolic and systolic diameters. Preferably if they are sequential, but when needed okay to skip one.
7. To determine diameter of interest is is necessary to scroll down the filmstrip and determine by eye the diameter changes, and use the ECG tracing to confirm. Note: given that sometimes the diameter changes are subtle, it is recommended to save the selected frame and the one before and after to ensure the correct diameter was chosen.
8. Save the frame either as a single frame TIF or JPEG using the command with a computer icon and film strip,

Image analysis
1. Open carotid analyzer
2. File→new→select image file note: only fill the subject id and condition (common).
3. Calibrate the image by placing the “calibration bulls-eye” directly on top of the calibration points, it usually read around 0.060 mm/pixel and marker distance is 10mm.
4. Press light bulb button to select the region of interest ROI, try to analyze 10 mm. The ROI may be smaller than 10mm, but try not to have it smaller than 4mm
5. Align the ROI with the artery direction, choose an area that is about 2cm from the carotid bulb on the right side →next
6. Diameters are obtained from M-line to M-line. First, the software will place the lines where it believes M-lines go→proceed
7. Results section. Display option: unclick “show I-lines” (yellow lines).
8. Select the “man” button. By default it says click to detect M-lines, leave as it. Select manual” to edit diameters manually.
9. Sensitivity: select the small arrow or the middle one, if purple lines are accurately over the M-lines there is no need to edit them. If not, click the left mouse button to displace the M-lines altogether. Then click on a corner of the M-line ROI and then start clicking along the line to place the purple line correctly along the M-line
10. Once both M-lines are edited, click on finish. Recored the diameter save as .sdy
11. Record the heart rate of the images analyzed. Note: do the same for all images.
12. Turn off computer then turn off optical disk.
C. CT Scan Analysis
1. Open SliceOmatic and then open your CT scan.
2. On the bottom right click **mixed**.
3. On the top toolbar hit **Modes ➔ Thresholding**
4. You will see a graph on your right with three distinct peaks. There are four bars on the right hand side (red, green, blue, purple). Move the red bar completely to the left.
5. Move the green bar so that the green overlay on the graph above is slightly to the left of center (there should be two larger peaks to the right of the green line and one peak to the left).
Note: You can jump back and forth between the original scan and the colored overlay scan by hitting F1 and F2.
6. Now move the blue bar so that the blue overlay is in between the group of middle peaks.
7. Once your CT scan looks sufficient click **Compute Segmentation** (directly below the bars you just slid).
8. On the top toolbar click **Modes ➔ Morpho**
9. On the right hand toolbar click **Compute all** And then click the number 4 right above it.
10. Above the compute all button there are circles of different sizes (this is the size of your paintbrush) choose the **largest brush** and click **red** use the large brush to color red over any excess blue and green located below the scan (These marks are from the table the patient was scanned on and should not be included in the calculation).
Note: Incase you make a mistake click the right mouse button to undo what you’ve just colored in. If you would like a closer view you can click on tools ➔ blow up on the top toolbar
Note: right above Compute all there are the numbers 1-4. Each of these buttons will outline either more or less of the scan. When you are coloring, only the areas outlined in yellow will be colored. Pick whatever number highlights the areas you want to color in
11. On the top toolbar click **Tools ➔ Tag Surface Volume**
12. Fill in the visceral fat with blue
13. Pick brush size and click on one of the numbers 1-4 to begin coloring in the center visceral fat area. (usually number 1 or 2 is a good place to start)
14. Color the entire area including all the green blue and red portions such that the only green left on the screen is the subcutaneous fat.
15. On the top toolbar click **Tools ➔ Tag Surface Volume**
Follow the same procedure as you did previously and copy down the number. This value is the subcutaneous fat value.
Appendix B: Informed Consent For Subjects

Information Sheet (Version 2)
Department of Human Nutrition, Foods and Exercise
Virginia Tech

TITLE: Weight Loss in Older Adults

INVESTIGATORS: Brenda M. Davy, PhD, RD; Kevin Davy, PhD; Janet Rankin, PhD; Richard A. Winett, PhD

MEDICAL DIRECTOR: Jose Rivero, M.D.

PURPOSE
You are being asked to participate in an experimental research study. Before you agree to be a volunteer in our study, we want you to understand what your participation will involve. Please read this form thoroughly prior to your first visit and let us know if you have any questions about its contents. The following information describes the study and your role as a participant.

The incidence of obesity is higher in older Americans (over age 60) than in the overall adult population (over age 18). Increased body weight is associated with higher risk for chronic diseases such as heart disease, diabetes, and cancer, as well as functional disabilities that may limit independence with advancing age. It is therefore important to study weight loss in older adults, and how this may improve heart health.

Seventy five people will participate in this study. To participate, you must be between the ages of 55 and 75 and be overweight. If you smoke, have been told by a doctor that you have a major chronic disease, for example, diabetes, cancer, chronic lung disease, kidney disease or thyroid disease, or if you are taking drugs that could affect your weight or appetite, you may not participate in this study. If the questionnaires that you fill out for us suggest that you have an eating disorder or that you may be depressed, you will not be able to participate in the study. Finally, if you have food allergies you may not be able to participate.

Following completion of the 12-week weight loss study, you have the option of continuing your research study participation for a 12-month weight loss maintenance follow-up study. A major challenge in the treatment of obesity is maintenance of weight loss. Many dieters regain about one third of the weight lost during the next year and are typically back to baseline in three to five years. Therefore, our purpose with this component of the study is to determine effective strategies for weight loss maintenance.

PROCEDURES
If you are interested in participating in this study, you will be required to visit War Memorial Hall for initial screening tests. You would be randomly assigned (like flipping a coin) to one of three groups. Two of these groups will be prescribed a low-calorie diet to help with weight loss for 12 weeks, but the two groups will receive different dietary instructions for losing weight. The third group will be a control group; individuals assigned to this control group will undergo all study procedures but will be asked not to change their diet or exercise habits. After 12 weeks, the people in the control group will be given the option of participating in a 12-week weight loss intervention if they would like. All participants will also be required to eat two breakfast meals in the laboratory to measure your feelings of hunger and fullness before starting weight loss, and two more breakfast meals at the end of the 12-week weight loss period. You will be asked not to change your current physical activity habits (exercise routine) during your participation in the 12-week low-calorie diet phase of the study.

Virginia Tech Institutional Review Board: Project No. 06-372
Approved July 17, 2008 to July 16, 2009
There will be approximately 15-20 visits to the Human Nutrition, Foods, and Exercise Department (228 War Memorial Hall) at Virginia Tech; 2 visits will take place at Montgomery Regional Hospital. All of these visits will take place over a 4-month period. The actual number and order of visits may vary depending upon your schedule and the availability of the study staff. All study procedures described in this document are done at no cost to participants.

**Session 1 (2 hours):** First we will explain the study to you, and have you read this information sheet. If you choose to participate, the following screening tests will be done:

- **Health History** – you will be asked to complete a medical history questionnaire. This procedure is used to screen for pre-existing disease or other reasons you should not participate in this study. Your height and weight will also be measured at this time. Your body weight will be measured on a standard balance scale and will include the weight of light indoor clothing or hospital gown without your shoes. **Blood Pressure** - You will be asked to sit quietly for 15 minutes. We will then measure your resting blood pressure using a stethoscope and standard blood pressure cuff and an blood pressure monitor. **Eating Habits and Depression Questionnaires** – you will complete two questionnaires that will be used to assess your eating habits and feelings of depression. If your scores on these questionnaires suggest that you may be depressed or have an eating disorder, you will be provided with contact information for the VT Psychological Services Center at 231-6914. You would be responsible for any costs related to follow-up care, if you decide to seek it.

- **4-Day Food Record** – you will be given instructions for how to record your food and beverage intake for four consecutive days. This may take you about 10-15 minutes total time each day. You will turn this in at the next visit.

**Session 2 (2 hours):** You will be asked to avoid eating for 12 hours prior to this visit so that the test results will not be influenced by the food you eat or by the normal digestion process. **Blood Draw** – a needle will be inserted into an arm vein to draw blood (approximately 2 tablespoons) to measure the levels of cholesterol and glucose. An additional 3 teaspoons will be frozen for other blood tests which may include levels of blood hormones which influence your appetite and risk of cardiovascular disease. The tests will be restricted to those relevant to the research project described. Any blood samples remaining after 10 years will be destroyed. **Body Fat Analysis** - a test called a DEXA will be done to measure your percent body fat. For this test, you will have to lie very still on a table for about 20 minutes while your body is scanned, similar to having an x-ray. You will need to wear shorts and a t-shirt for this visit. Women should not wear bras or metal underwires. There is no pain associated with this test. **24-Hour Urine Collection** – you will be given a container for collecting your urine for a 24-hour period. We will give you instructions for how to do this test, and you will be asked to keep your urine collection refrigerated (we will provide coolers with freezer packs to help with this). **Food Record -** you will turn in your food record at this visit.

- **Blood Flow in Heart and Arteries** – the blood flow and diameter in the arteries in your neck, arm and leg will be measured with an ultrasound machine. An ultrasonic machine is sort-of like radar – a low frequency radio wave that bounces off the tissues and sends a picture back to a ‘TV-like’ screen. A mobile hand unit used will be pressed gently against an artery in your neck, arm and leg. The amount of blood that your heart pumps in one minute and other measures of heart function will be determined with another ultrasound probe. For these measurements, the probe will be pressed gently against two different places on your chest. Your blood pressure will also be measured.

**Session 3 (3 hours):** You may not eat or drink anything except water for 12 hours prior to this visit. We will measure your weight when you arrive for this visit, and you will return your urine
collection from visit 2. This visit will be scheduled in the morning, typically beginning between 8a and 10:30a.

**Breakfast Meal** – you will be provided with a breakfast meal consisting of typical breakfast items (muffins, jam, fruit, etc). You may eat as much as you like.

**Visual Analog Scales (VAS)** – Visual Analog Scales (VAS) are ratings of hunger, fullness, thirst and desire to eat. They consist of questions such as “How hungry are you right now?” to address hunger, thirst, nausea, and fullness. You will be asked to complete VAS at 6 time points on each testing day; 30 minutes before the meal, immediately before and after meal, and 30, 60 and 90-minutes after the meal.

**Session 4 (4 hours):** This visit will be similar to visit 3. You may not eat or drink anything except water for 12 hours prior to this visit. We will measure your weight when you arrive for this visit. This visit will be scheduled in the morning, typically beginning between 8a and 10:30a.

**Breakfast Meal** – you will be provided with a breakfast meal consisting of typical breakfast items (muffins, jam, fruit, etc). You may eat as much as you like.

**Visual Analog Scales (VAS)** – Visual Analog Scales (VAS) are ratings of hunger, fullness, thirst and desire to eat. They consist of questions such as “How hungry are you right now?” to address hunger, thirst, nausea, and fullness. You will be asked to complete VAS at 6 time points on each testing day; 30 minutes before the meal, immediately before and after meal, and 30, 60 and 90-minutes after the meal.

**Weight Loss Diet** - at this visit, you will be instructed in a low-fat (20-30% fat), low-calorie diet which should help you lose weight. We will individualize this diet for you so that it takes into account factors like your dietary preferences and body size. We will provide you with sample menus to use during this part of the study. You will be asked to follow this diet for 12 weeks. During the 12-week period, we will check your weight each week and provide you with assistance/feedback and tips for adhering to your diet. We will also ask you for urine samples every other week to see how well hydrated you are (the amount of fluid in your body).

**Session 5 (1 hour):** This visit will take place at Montgomery Regional Hospital. You will be asked to avoid eating for at least 4 hours prior to this visit.

**Computed Tomography Scan** – the amount of total fat, fat around your internal organs, and the fat under the skin in the abdominal area will be measured by computed tomography (CT scan). The CT scan imaging will be performed at Montgomery Regional Hospital. For this procedure, you will be asked to lie still on a table. An x-ray machine (the CT scanner) will rotate around you and the table will move back and forth slightly making it possible to take X-rays from several angles. The actual x-ray time is approximately 2 minutes or less. You will be lying on the table for approximately 15 to 30 minutes. The approximate time required for the entire procedure is one hour. A longer period of time may be required due to heavy scheduling and/or emergency need of the CT scan at the Montgomery Regional Hospital.

**Sessions 6-16 (15-30 minutes each):** Once you begin your diet, you will be asked to come into the lab every 1-2 weeks to be weighed and have your blood pressure taken, and we will ask you if you are having any problems with following your diet that we can help you with. Every other week, you will be asked to keep another 24-hour urine collection and record everything that you eat and drink.

**Session 17 (2 hour):** This session will be the same as session 2.

**Sessions 18 and 19 (3 hours each):** This session will be the same as session 3.

**Session 20 (1 hour):** This session will be the same as session 5.

**The total time commitment for this study will range from approximately 24-27 hours.**
OPTIONAL STUDY EXTENSION: 12-Month Weight Maintenance

At the conclusion of sessions 17 through 20, if you are interested in participating in this study, you will begin a one year study that assesses strategies to help maintain weight lost during the first part of this research study. As with the first part of the study, the two weight loss maintenance groups will receive slightly different guidance on how to maintain their weight loss. Both groups will receive information on ways to increase physical activity.

There will be approximately 12-15 visits to the Human Nutrition, Foods and Exercise Department (228 War Memorial Hall) at Virginia Tech. All of these visits will take place over a one-year period. The actual number and order of visits may vary depending upon your schedule and the availability of the study staff. In addition to visits, all study participants will have to submit brief weekly health logs via e-mail, fax, phone or face to face. This will take approximately 5-10 minutes of your time each week. As with the first part of the study, all study procedures described in this part of the study are done at no cost to participants.

**Session 21 (15-30 minutes):** This session may be combined with session 19 of the phase 1 study. We will explain the 12-month study to you, and have you re-read this information sheet. If you choose to participate, the following screening test will be done:

Health Belief Questionnaire – you will be asked to complete a Health Belief Model questionnaire. This procedure is used to assess subject’s knowledge of health behaviors and perceptions of positive behavior change.

**Session 22 (1 hour):** You will be asked to avoid eating and drinking for 12 hours prior to this visit. You will be asked to come to the lab early in the morning, well-rested and having avoided strenuous activity 12 hours prior this visit.

Resting Metabolic Rate – your resting metabolic rate is the amount of energy (calories) expended while at a resting state. For this test, you will have to lie very still on a table for 45 minutes to 1 hour while breathing into a transparent apparatus that covers your head and shoulders. Normal clothes can be worn. There is no pain associated with this test.

**Sessions 23-27 (15-30 minutes):** Once you begin your weight maintenance, you will be asked to come into the lab every month to be weighed and have your blood pressure taken, and we will ask you if you are having any problems with following your diet that we can help you with. You will be asked to complete a 4-Day Food Record each month, as well as an activity record. These monthly sessions will take place during your initial 6 months of weight maintenance.

**Session 28 (2 hours):** This session will be similar to session 2, and it will take place in the morning. You may not eat or drink anything for 12 hours prior to this visit. We will measure your weight when you arrive for this visit. The visit will be scheduled in the morning, typically between 8a and 10:30a. This session will take place during your sixth month of weight maintenance.

**Sessions 29-34 (15-30 minutes):** This session will be the same as sessions 23-27, and take place in months 7-12 of weight maintenance.

**Session 35 (2-3 hours):** This session will be the same as session 28 with the addition of resting metabolic rate. This session will take place in the final month of the 12-month weight maintenance phase.

**Session 36 (1 hour):** This session will be to provide you with an analysis of your participation in the weight maintenance study, such as your test results, and answer further questions.
SUMMARY OF SUBJECT RESPONSIBILITIES

- Provide an accurate history of any health problems or medications you use before the study begins.
- Inform the experimenters of any discomfort or unusual feelings before, during or after any of the study sessions.
- Be on time and attend all of the scheduled sessions.
- Follow all participant instructions for each session.
- Not change current physical activity levels.
- Record the food you eat as instructed by the study investigators.

RISKS OF PARTICIPATION

- **Blood Draw:** Some pain or discomfort may be experienced when the needle is inserted in the vein, but this persists for only a short time. During the blood draws, you may have pain and/or bruising at the place on your arm where the blood is taken. In about 1 in 10 or 10% of the cases, a small amount of bleeding under the skin will cause bruises. The risk of a blood clot forming in the vein is about 1 in 20 (0.005%), while the risk of infection or significant blood loss is 1 in 1000 (0.001%). There is a small risk of the vein becoming inflamed and/or painful in the hours or days after the catheter is removed. If you feel faint during or after a blood draw, you should notify the study staff immediately and lie down right away to avoid falling down. Having staff who are experienced in blood draws will minimize these risks.

- **HIV/AIDS:** Your blood will be tested for the presence of HIV if one of the study investigators is exposed to your blood. There will not be any cost to you for this test. The results will be sent to your primary care physician or the study medical director, Dr. Jose Rivero, if you do not have a primary care physician. He/she will discuss them with you and provide you with the necessary referral for further evaluation and/or counseling if your results are positive. The results of your test will remain confidential.

- **DEXA Scan:** The amount of radiation that you will receive in the DEXA exam is less than the amount permitted by the Food and Drug Administration (FDA) per year. The amount you will receive is equal to 1/20 of a chest x-ray. The more radiation you receive over the course of your lifetime, the more likely your risk increases in developing cancerous tumors. The radiation in this study is not expected to greatly increase these risks, however the exact increase in such risk is not known.

- **CT scan:** The amount of radiation that you will receive in the CT scan (combined with the DEXA exam) is less than the amount permitted by the Food and Drug Administration (FDA) per year. The amount you will receive is less than that received from a chest x-ray. The more radiation you receive over the course of your lifetime, the more likely your risk increases in developing cancerous tumors. The total amount of x-ray exposure from both the DEXA and CT scan is less than a chest x-ray. The radiation in this study is not expected to greatly increase these risks, however the exact increase in such risk is not known. You should know that the CT scan for this study is for research purposes and not for diagnosis. The CT scan will not be reviewed or saved for future purposes by Montgomery Regional Hospital.

- **Weight Gain:** Weight gain is common following weight loss programs. It is possible that you will gain some or all of the weight you lost during the study. We can make no promises or commitments on the long term success of maintaining your weight loss. This is a possibility that you should consider before you agree to participate.

- It is not possible to identify all potential risks in an experiential study, however the study doctors and study staff will take all possible safeguards to minimize any known and potential risks to your well-being. We believe the overall risks of participation are minimal. All of the procedures are well established and used routinely in the study investigators laboratory. Side effects are possible in any research study despite high standards of care, and could occur through no fault of your own or the study staff.
BENEFITS OF PARTICIPATION
Your participation will provide you with:
- Information on your body composition and diet
- Information on a low-fat weight loss diet, supervised by a registered dietitian
- Support, information and feedback for weight loss maintenance, if you choose to participate in the optional 12-month follow-up part of the study.

COMPENSATION
We will pay you $50 for completion of all sessions involved with the 12-week study. If you dropout of the study or are unable to complete the study, you will be paid a prorated amount for those sessions you complete ($2.50 per session completed). You will not be paid for completing the 12-month optional follow-up study.

CONFIDENTIALITY
The data from this study will be kept strictly confidential. No data will be released to anyone but those working on the project without your written permission. Data will be identified by subject numbers, without anything to identify you by name.

FREEDOM TO WITHDRAW
You are free to withdraw from the study at any time for any reason. Simply inform the experimenters of your intention to cease participation. Circumstances may come up that the researcher will determine that you should not continue as a subject in the study. For example, lack of compliance to instructions, failure to attend testing sessions and illness could be reasons for the researchers to stop your participation in the study.

INJURY DURING PARTICIPATION IN THIS STUDY
Neither the researchers nor the university have money set aside to pay for medical treatment that would be necessary if injured as a result of your participation in this study. Any expenses that you incur including emergencies and long-term expenses would be your own responsibility.
You should consider this limitation before you consider participating in this study.

APPROVAL OF RESEARCH
This research has been authorized, as required, by the Institutional Review Board for Research Involving Human Subjects at Virginia Tech, and by the Department of Human Nutrition, Foods, and Exercise. You will receive a copy of this form to take with you.

SUBJECT PERMISSION
I have read the informed consent and fully understand the procedures and conditions of the project. I have had all my questions answered, and I hereby give my voluntary consent to be a participant in this research study. I agree to abide by the rules of the project. I understand that I may withdraw from the study at any time.

If you have questions, you may contact:
- Principal Investigator: Brenda Davy, Assistant Professor, Department of Human Nutrition, Foods, and Exercise, (540) 231-6784
- Co-Investigator: Kevin Davy, Associate Professor, Department of Human Nutrition, Foods, and Exercise, (540) 231-3487
- Chairman, VT Institutional Review Board for Research Involving Human Subjects: David Moore, (540) 231-4991
- Chairman, Montgomery Regional Hospital Institutional Review Board: Chris Riegert, RPh, (540) 953-5118.
Name of Subject (please print) ________________________________

Signature of Subject ___________________________ Date ______

Name of Person Obtaining Consent (print) ________________________________

Signature of Person Obtaining Consent ___________________________ Date ______
Appendix C: Institutional Review Board Approval

MEMORANDUM

DATE: June 23, 2011

TO: Brenda M. Davy, Kevin P. Davy, Janet W. Rankin

FROM: Virginia Tech Institutional Review Board (FWA00000572, expires May 31, 2014)

PROTOCOL TITLE: Weight Loss in Older Adults

IRB NUMBER: 06-372

Effective July 17, 2011, the Virginia Tech IRB Chair, Dr. David M. Moore, approved the continuation request for the above-mentioned research protocol.

This approval provides permission to begin the human subject activities outlined in the IRB-approved protocol and supporting documents.

Plans to deviate from the approved protocol and/or supporting documents must be submitted to the IRB as an amendment request and approved by the IRB prior to the implementation of any changes, regardless of how minor, except where necessary to eliminate apparent immediate hazards to the subjects. Report promptly to the IRB any injuries or other unanticipated or adverse events involving risks or harms to human research subjects or others.

All investigators (listed above) are required to comply with the researcher requirements outlined at http://www.irb.vt.edu/pages/responsibilities.htm (please review before the commencement of your research).

PROTOCOL INFORMATION:
Approved as: Full Board Review
Protocol Approval Date: 7/17/2011 (protocol's initial approval date: 7/17/2006)
Protocol Expiration Date: 7/16/2012
Continuing Review Due Date*: 7/2/2012
*Date a Continuing Review application is due to the IRB office if human subject activities covered under this protocol, including data analysis, are to continue beyond the Protocol Expiration Date.

FEDERALLY FUNDED RESEARCH REQUIREMENTS:
Per federally regulations, 45 CFR 46.103(f), the IRB is required to compare all federally funded grant proposals / work statements to the IRB protocol(s) which cover the human research activities included in the proposal / work statement before funds are released. Note that this requirement does not apply to Exempt and Interim IRB protocols, or grants for which VT is not the primary awardee.

The table on the following page indicates whether grant proposals are related to this IRB protocol, and which of the listed proposals, if any, have been compared to this IRB protocol, if required.
<table>
<thead>
<tr>
<th>Date*</th>
<th>OSP Number</th>
<th>Sponsor</th>
<th>Grant Comparison Conducted?</th>
</tr>
</thead>
<tbody>
<tr>
<td>6/21/2010</td>
<td>08054809</td>
<td>International Life Sciences Institute</td>
<td>Not Required (not federally funded)</td>
</tr>
<tr>
<td>6/21/2010</td>
<td>06164702</td>
<td>Institute for Public Health &amp; Water</td>
<td>Not Required (not federally funded)</td>
</tr>
</tbody>
</table>

*Date this proposal number was compared, assessed as not requiring comparison, or comparison information was revised.

If this IRB protocol is to cover any other grant proposals, please contact the IRB office (irbadmin@vt.edu) immediately.

cc: File
OSP